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1 Getting started

Your printer is a general purpose color inkjet printer that provides high 
quality text and photos. You can use your printer by itself to print photos or 
connect it to a computer for other printing needs. The following sections will 
tell you how to set up your printer for Windows 98, Windows Me, Windows 
2000 and Macintosh.

Note: To access the on-line User’s Guide for Windows 2000 or 
Macintosh, click on Read User’s Guide under Learn on 
the CD front end prior to installing your software. This will 
let you copy and/or view the User’s Guide from your 
computer. After setting up your printer, this hard copy 
User’s Guide applies only to Windows98/Me.

Setting up your printer 

1 Connect the power supply.

Note: Connection 2, above may not be required in some 
countries.

1

2 3
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Select Language appears on the operator panel display to 
indicate the power is on.

Note: If you need help identifying the operator panel buttons, see 
page 15.

2 Press on the operator panel to scroll through the 
languages.

3 Press Select when you see the language you want.

Select Paper Size appears on the operator panel display. 

4 Press on the operator panel to scroll through the paper 
sizes. 

5 Press Select when you see the paper size you want.

6 Continue with “Installing the print cartridges” in the following 
section.

Installing the print cartridges

1 Remove the sticker and transparent tape from the bottom of the 
print cartridge. 

Note: Be sure to remove the tape and install the cartridges one at 
a time to prevent leaking.

or

or

Warning: DO NOT 
touch the gold 
contact area of the 
print cartridges.
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2 Insert the color cartridge in the left slot and the photo cartridge in 
the right slot.

Note: To replace the photo cartridge with a black cartridge, see 
page 54. 

3 Close the front cover.

Snap

Raise the front 
cover.

Insert the 
cartridges into the 
print cartridge 
carrier.

Push back firmly on 
the cartridge until it 
snaps securely into 
place. 

a b c

a b

c
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Loading paper

1 Pull out the paper support and paper exit tray. 

2 Place paper against the right side of the sheet feeder with the print 
side facing you.

3 Squeeze the release tab and the paper guide together, and then 
slide the paper guide to the left edge of the paper. 

Paper exit tray

Paper support

Paper guide

Release tab
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Aligning the print cartridges 

1 Load plain paper in the printer. For help loading paper, see the 
previous section.

2 Press Menu.

3 Press  until Utilities is highlighted, and then press Select.

The Utilities menu appears.

4 Press  until Align Cartridges is highlighted, and then press 
Select.

5 Press  until Yes is highlighted, and then press Select.

“Printing Page, Please Wait” message appears.

The test page prints several alignment patterns, depending on the 
cartridge combination installed. Each pattern has a number under 
it. The test page that prints is similar to the one shown:

6 Choose Values With Straightest Lines message appears, press 
Select to continue.

7 From each alignment group on the test page, find the number 
under the alignment pattern that comes closest to forming a 
straight line.

For example, in sample group A, the arrow points to the pattern 
that comes closest to forming a straight line.

Note: If you have a color and 
black cartridge combination 
installed, you will have two more 
alignment values, C and D. 
Follow the same instructions as 
you would for the color and 
photo cartridge combinations.



G
et

ti
n

g
 s

ta
rt

ed

6

The Align Cartridge Choose Values screen appears.

8 In the Align Cartridge dialog box, press to select the 
numbers from the printed test page that come closest to forming a 
straight line.

9 Press  to highlight Continue and press Select.

10 Press Menu to exit the printer menus.

Printing a test page

1 Make sure no camera card is inserted.

2 Press Print to print a test page.

Setting up your printer with Windows 98

Before you begin:

• Prepare your printer for printing. For help, see page 1.
• Make sure you have a USB cable.
• Make sure Microsoft Windows 98 is running on your PC.

To install the KODAK PPM200 printer software:

1 Connect the USB cable to the computer and printer.

or
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2 Click Next when the first screen appears.

Note: When you connect your printer to a computer, the Microsoft 
Windows software on your computer detects new 
hardware and asks you to navigate through the “Add New 
Hardware Wizard” with a series of dialog boxes. Complete 
the following steps to finish this process and reach the 
KODAK PPM200 Install Printer Software screen.

3 Place the KODAK PPM200 Printer Software CD into your 
computer’s CD-ROM drive.

4 Make sure the first option is selected on the second screen, and 
then click Next.

5 Select the CD-ROM option on the next screen, and then click 
Next.

6 Click Next or Finish on any subsequent screens.

The KODAK PPM200 software installation screen appears.

Note: Prior to installing the KODAK PPM200 software, you can 
choose other options such as Learn, Registering online or 
Browse (KODAK Web Site, Technical Support or Personal 
Picture Maker Supplies).

7 Choose from the following install options:

– Personal Picture Maker Driver
– KODAK Picture Page Software
– Install All Software

Note: You must choose Personal Picture Maker Driver or 
Install All Software to enable PC printing.
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8 Follow the on-screen instructions.

Note: If the KODAK PPM200 screen does not appear, click Start, 
Run. Type the letter of your CD-ROM drive followed by 
:\setup and then click OK.

Congratulations!

You have successfully set up your printer for Windows 98.

Setting up your printer with Windows Me

Before you begin:

• Prepare your printer for printing. For help, see page 1.
• Make sure you have a USB cable.
• Make sure Windows Me is running.

1 Connect the USB cable to the computer and the printer. For help, 
see page 6.

Note: When you connect your printer to a computer, the Microsoft 
Windows software on your computer detects new 
hardware and asks you to navigate through the “Add New 
Hardware Wizard” with a series of dialog boxes. Complete 
the following steps to finish this process and reach the 
KODAK PPM200 Install Printer Software screen.

2 Place the KODAK PPM200 Printer Software CD into your 
computer’s CD-ROM drive.

3 Make sure the first option, Automatic search for a better driver, 
is selected, and then click Next.

Note: Skip steps 4 and 5 if the following screen does not 
appear.

The Select Other Driver screen appears.

4 Select the Inkjet Color Printer LEXUSB.INF file, and then click 
OK.
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5 Click Next or Finish on any subsequent screens.

The KODAK PPM200 software installation screen appears.

Note: Prior to installing the KODAK PPM200 software, you can 
choose other options such as Learn, Registering online or 
Browse (KODAK Web Site, Technical Support or Personal 
Picture Maker Supplies).

6 Choose from the following install options:

– Personal Picture Maker Driver
– KODAK Picture Page Software
– Install All Software

Note: You must choose Personal Picture Maker Driver or 
Install All Software to enable PC printing.

7 Follow the on-screen instructions.

8 If the KODAK PPM200 screen does not appear, click Start, Run. 
Type the letter of your CD-ROM drive followed by :\setup and then 
click OK.

Congratulations!

You have successfully set up your printer for Windows Me.

Setting up your printer with Windows 2000

Before you begin:

• Prepare your printer for printing. For help, see page 1.
• Make sure you have a USB cable.
• Make sure Windows 2000 is running.

1 Connect the USB cable to the computer and the printer. For help, 
see page 6.

The Microsoft Windows software appears on your computer to 
detect new hardware. 
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2 Click CANCEL.

3 Place the KODAK PPM200 Printer Software CD into your 
computer’s CD-ROM drive.

The KODAK PPM200 software installation screen appears.

Note: Prior to installing the KODAK PPM200 software, you can 
choose other options such as Learn, Registering online or 
Browse (KODAK Web Site, Technical Support or Personal 
Picture Maker Supplies).

4 Choose from the following install options:

– Personal Picture Maker Driver
– KODAK Picture Page Software
– Install All Software

Note: You must choose Personal Picture Maker Driver or 
Install All Software to enable PC printing.

5 Follow the on-screen instructions.

6 If the KODAK PPM200 screen does not appear, click Start, Run. 
Type the letter of your CD-ROM drive followed by :\setup and then 
click OK.

Congratulations!

You have successfully set up your printer for Windows 2000.

Setting up your printer with a Macintosh

Before you begin:

• Prepare your printer for printing. For help, see page 1.
• Make sure you have a USB cable.
• Make sure Mac OS 8.6 or Mac OS 9 is running on your Macintosh 

computer.
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To install the KODAK PPM200 printer software:

1 Connect the USB cable to the computer and the printer.

2 Place the KODAK PPM200 Printer Software CD into your 
computer’s CD-ROM drive. 

The KODAK PPM200 Installer main screen appears.

3 Click Install and Agree.

The KODAK License Agreement screen appears.

4 Click Accept.

The KODAK PPM200 Installer screen appears.

5 Click Install.

The KODAK PPM200 Printer Selection screen appears.

6 Follow the on-screen instructions.

Note: Prior to installing the KODAK PPM200 software, you can 
choose other options such as Learn, Registering online or 
Browse (KODAK Web Site, Technical Support or Personal 
Picture Maker Supplies).

Congratulations!

You have successfully set up your printer on a Macintosh computer.

Note for Macintosh Users:

If your Macintosh computer locks up or freezes while printing, you may 
need to unplug the printer and turn off your computer. After a few seconds, 
plug the printer back in and turn your computer back on. The printer 
driver’s spooler may attempt to start printing the job that was in the queue 
before the computer locked up. This could cause your system to lock up 
again. To recover from this problem:

1 Unplug the printer and turn off your computer.

2 Hold down the Shift key and turn on the computer.
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3 Press and hold the Shift key until you see the Mac OS screen and 
the words “Extensions Off”.

4 Release the Shift key.

5 Locate the KODAK PPM200 printer icon on your desktop. The 
inactive printer spooler has an X over it.

6 Double-click the icon to open the KODAK PPM200 dialog box.

7 Drag your print jobs to the trash can.

8 Restart the computer to enable extensions.

9 Plug your printer back in.
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Understanding your printer

This chapter describes the parts of your printer and their functions.

Identifying the parts of your printer 

Use this... When you want to...

Paper support Keep paper straight in the sheet feeder.

Release tab,

Paper guide

Make sure the paper feeds correctly into your 
printer. 

Sheet feeder Load paper. 

Front cover Install or change print cartridges, or clear paper 
jams.

Paper exit tray Keep paper together after printing.

Camera card cover Insert or remove a camera card.

Paper support

Release tab

Camera card 
cover 

Paper exit tray

Sheet feeder

Operator panel

Front cover
Paper guide
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Operator panel • Select setup options.
• Select photos for printing.
• Select special printing options.
• Select photo storage options.
• Display and clear status or error messages.

Use this... When you want to...

Power supply connector Plug the power supply into the printer.

USB/PC cable 
connector

Attach the printer to a computer. 

USB external device 
connector

Attach a Zip drive to the printer. 

Use this... When you want to...

Power supply 
connector

USB/PC cable 
connector

USB external 
device 
connector
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Using the operator panel 

 

Verifying camera compatibility 

Your printer is compatible with most types of digital cameras that use 
CompactFlash or SmartMedia camera cards. Visit our Web site at 
www.kodak.com/go/homeprinting for the latest camera compatibility list.

Use this... When you want to...

Menu button Enter and exit the menus.

Arrow button Navigate through the menus and view your photos.

Display window Raise or lower the display to view the menus and your 
photos.

Brightness control Adjust the brightness or contrast of the display.

Select button Select or cancel a photo, enter a submenu, or accept 
menu settings.

View/Return button Change from one view to another or return to a previous 
menu level without saving changes from the current 
menu option.

Print button Begin printing.

Menu 
button

Print button
View/Return 
button

Select 
button

Arrow 
button

Brightness 
control

Display 
window
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Inserting a camera card

Before inserting a camera card into its card slot, lift the protective cover 
located on the top of your printer.

Choosing a camera card slot

Your printer recognizes one source for photos at a time and searches for 
photos in the following order:

• Left slot (CompactFlash)
• Right slot (SmartMedia)
• Optional external devices (see page 33)

Consider the following information before inserting a camera card:

• If the camera card has a gold contact area, make sure the contact 
area faces the front of your printer.

• If you are inserting a CompactFlash card, make sure the name 
label faces the back of your printer.

• If you are inserting the SmartMedia card, make sure you do not 
place it in the CompactFlash card slot.

• If your camera card or storage disk contains photo images, a 
Reading Card message appears in the display window. The 
number of photos contained on the card is also displayed.

SmartMedia 

Gold contact 
area

CompactFlash 

Camera card 
slot cover
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Using the Quickstart screen

When you insert your camera card into your printer or if you are printing 
photos from an external device, a Quickstart screen appears that gives 
you easy print options.You do not need to enter the Main Menu of the 
printer.

The following table lists the start-up screen options:

To use the Quickstart screen:

1 Insert the appropriate camera card or connect your external device 
containing photo images.

The Quickstart screen appears.

2 Press  to scroll through the options until the selection you 
want is highlighted.

3 Press Select.

Use the up and 
down arrows to 
select... When you want to...

Print All Print all the photos from your camera card or external 
device. 

Print Camera Order Print the photo selections chosen in your camera.

Note: This option is only visible when you have selected 
photos for printing using your camera.

View Photos View and select photos for printing.

Print Index Print thumbnail size photos.

PC Card Reader View or copy photos to your computer.

Note: This option is only visible if you are connected to 
your computer. See page 42.

Change Layout Change the way your photos are printed on paper.

or
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Note: To return to the Quickstart screen, remove and reinsert 
your camera card. This resets or clears all current photo 
selections.

Using Photo and Print Preview 

These screens let you select photos and review them before printing. 

To use Photo and Print Preview:

1 Press  to highlight View Photos from the Quickstart screen and 
then to view and scroll through your photos.

2 Press Select to choose the photos you want to print.

3 Press View/Return to preview your selections.

Note: Pressing View/Return changes between photo and page 
preview screens.

4 Press Print.

Note: The Page Preview screens show what your selections will 
look like, the current settings, and the number of pages to 
be printed.

Understanding the Idle Screen

An idle screen appears on the display if there is no camera card in the 
printer. This screen provides you with the current photo printer settings. 
The display goes blank after approximately 30 minutes. Press any key on 
the operator panel, or open the printer’s front cover to activate the display.

Changing Languages

Choose the Language option to change the language that appears on the 
operator panel display.

or
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To change the Language Default:

1 Press Menu until you see the Main Menu.

2 Press  until Preferences is highlighted, and then press Select.

The Preferences menu appears.

3 Make sure Language is highlighted and press Select.

4 Press on the operator panel to scroll through and select 
the language you want.

or
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Printing photos without
a computer

This chapter describes how to print and edit photos using the printer 
menus. 

Understanding the Printer Menus

If you want to print photos using more detailed options, change print 
settings, or access other printer functions, go to the printer menu by 
pressing the Menu button. 

To use the Menu:

1 Press the Menu button. 

2 Press  to scroll and highlight the menu category you want.

 Menu Categories

PreferencesUtilitiesPaper 
Settings

StorageEdit PhotoPrint Setup

Photos to Print
Layout
Print Quality
Sets

Paper Type
Paper Size

Crop
Rotate
Add Border
Add Text
Brightness
Auto Enhance
Undo all Edits

Copy Card
Erase Card

PC Card Reader
Ink Level
Clean Cartridge
Align Cartridge
Reset Defaults

Language

or
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3 Press Select.

4 Press  to navigate through the sub-menus and choose 
the option you want.

5 Press Select.

Notes: The current setting is identified with a check mark next to it. 
Press View/Return to go back one menu level or you can 
press Menu at anytime to return to Photo and Print 
Preview.

The current settings for the highlighted category appear in 
the bottom right corner of the display.

Choosing a paper type from the operator panel

1 Press Menu until you see the Main Menu.

2 Press  to highlight Paper Settings, and then press Select.

The Paper Settings menu appears showing your current 
selections.

3 Make sure Paper Type is highlighted, and then press Select.

The Paper Type menu appears.

Press  to select a paper type.

Choose this Paper 
Type... For making... For best results, use...

Photo • Ultra glossy photo prints. • KODAK Premium 
Picture Paper.

Plain • Economical photo prints. • Typical xerographic 
paper.

and

and
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We recommend KODAK Premium Picture Paper for the best print quality. 

For information about ordering paper, visit the World Wide Web at 
www.kodak.com/go/inkjet.

Choosing a paper size

1 Press Menu until you see the Main Menu.

2 Press  to highlight Paper Settings, and then press Select.

The Paper Settings menu appears showing your current 
selections.

3 Press  to highlight Paper Size, and then press Select. 

The Paper Size menu appears.

Kodak Templates

Note: After selecting 
this option, you will 
need to select the 
template number you 
are using. For a list of 
Kodak templates, see 
page 25.

• Multiple photo layouts on 
pre-perforated sheets.

• KODAK Premium 
Picture Kit for 
borderless prints.

Iron-on transfer (or 
T-Shirt)

• Photo prints for iron-on 
transfer to fabric.

• Iron-on media.

Transparencies • Transparencies for 
overhead projectors.

• Transparency media.

Choose this Paper 
Type... For making... For best results, use...
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4 Press  to select a paper size.

Changing print quality

1 Press Menu until you see the Main Menu.

2 Make sure Print Setup is highlighted, and then press Select.

The Print Setup menu appears.

3 Press  until Print Quality is highlighted, and then press Select.

4 Press  to choose from the following print quality options:

– Best
– Better (default setting)
– Good

Note: Increasing print quality reduces print speed.

5 Press Select.

Choosing the page layout 

1 Press Menu until you see the Main Menu.

2 Make sure Print Setup is highlighted, and then press Select.

The Print Setup menu appears.

3 Press  until Layout is highlighted, and then press Select.

Select this 
option... To choose...

Paper Size • 8.5 x 11
• A4 
• 4 x 6
• A6
• Hagaki

and

and
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The Page Layout menu appears. (See the following table for an 
overview of the page layout options.)

4 Press Select to save your selection or View/Return to exit the 
menu without changing the settings.

Notes: The panoramic and border options on your printer are not 
available when you use Kodak Templates.

Press the left or 
right arrow to 
scroll and 
choose...

Then, press the down arrow and then use the left and 
right arrows to scroll and choose from the following 
layout options:

Print Sizes. • 8 x10 -1 per page
• 4 x 6 - 2 per page
• 5 x 7 - 2 per page
• 3.5 x 5 - 4 per page
• 2 x 3 - 8 per page
• 1.75 x 2 - 16 per page

Kodak Templates. • EK-PH-001 - (1) 8” x 10” (letter size paper)
• EK-PH-002 - (2) 5 x 7 prints on letter size paper
• EK-PH-003 - (2) 4 x 6 prints on letter size paper
• EK-PH-004 - (4) 3.5 x 5 prints on letter size paper
• EK-PH-005 - (6) 2.5 x 3.5 prints on letter size paper
• EK-PH-009 - (3) 3.5 x 8.5 prints on letter size paper
• EK-PH-010 - (1) 4 x 6 on 8.25” x 4.5” paper
• EK-PH-011 - (1) 100 x 150 mm on A5 size paper
• EK-PH-102 - (2) 127 x 177 mm on A4 size paper
• EK-PH-103 - (2) 102 x 152 mm on A4 size paper
• EK-PH-104 -(4) 90 x 130 mm on A4 size paper
• EK-PH-105 - (6) 57 x 89 mm on A4 size paper

Panoramic
(only supported in 
letter and A4 size 
papers).

• Center
• Lower Center
• Lower
• Top
• Upper Center
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You can also use the Kodak Template menu settings with 
regular photo paper. Cut the photos to fit your frame to 
create standard size, borderless prints.

Selecting photos to print 

1 Insert the appropriate camera card.

2 Press  to highlight View Photos.

3 Press Select.

4 Press  to scroll through your photos.

5 Press Select for each photo you want to print.

6 Press to increase or decrease the number of copies for 
each selected photo.

Note: A check mark appears in the lower left corner indicating the 
photo is chosen. To remove the selection, press Select 
again.

7 Press View/Return, and then press  to review the selections 
you have chosen.

8 Press Print to begin printing or Menu to select or change other 
print settings.

Using the Photos to Print option

1 Press Menu until you see the Main Menu.

2 Make sure Print Setup is highlighted, and then press Select.

The Print Setup menu appears.

3 Make sure Photos to Print is highlighted, and then press Select.

The Photos to Print menu appears.

4 Press  to choose from the following options:

or

or

or

or
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– Selected Photo - Prints photos selected from the operator 
panel in the full photo view.

– Print Camera Order - Prints photos you selected on your 
digital camera.

Note: Print Camera Order only appears if you have selected 
photos within the camera.

– Print All - Prints all photos.
– Print Index - Prints small numbered photos with file names.

5 Press Select.

Printing starts immediately.

Choosing the number of sets to print

Select Sets to print more than one copy of your photo grouping.

1 Press Menu until you see the Main Menu.

2 Make sure Print Setup is highlighted, and then press Select.

The Print Setup menu appears.

3 Press  until Sets is highlighted, and then press Select.

4 Press  to scroll and select the number of sets you want to 
print.

5 Press Select.

Photo Editing Selections

To edit photos currently shown on the display, select:

• Crop
• Rotate
• Add Border 

or
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• Add Text (You can also modify text when choosing this option, for 
help, see page 30.)

• Brightness
• Auto Enhance
• Undo All Edits

Notes: Edits are applied only to the current photo displayed in the 
photo view.

After you edit a photo, Edited will appear in the lower right 
corner of the display in photo view. You will only see the 
changes you made to your photo when it is printed.

Cropping photos

To crop or select specific areas of photos:

1 Press Menu until you see the Main Menu.

2 Press  to highlight Edit Photo, and then press Select.

The Edit menu appears.

3 Make sure Crop is highlighted, and then press Select.

4 Press  or  to move the crop window around the 
photo.

5 Use arrows to position the crop box.

6 Press Select.

Notes: To undo a previous crop, return to the Crop menu and 
press Select. To redo a previous crop, return to the Crop 
menu and use the arrows to reposition the crop box.

You cannot use crop and panoramic view on a photo at 
the same time.

Rotating a photo

1 Press Menu until you see the Main Menu.

and and
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2 Press  to highlight Edit Photo, and then press Select.

The Edit menu appears.

3 Press  to highlight Rotate, and then press Select.

The Rotate menu appears.

4 Press  to scroll and select an angle, and then press Select.

Notes: Depending on the photo size chosen, the rotated photo 
may print smaller than the selected size. 

Text added to you your photo will not rotate with the 
image.

Rotating TIFF images can take a very long time and is not 
recommended.

Selecting a border for your photo

1 Press Menu until you see the Main Menu.

2 Press  until Edit Photo is highlighted, and then press Select.

The Edit menu appears.

3 Press until Add Border is highlighted, and then press 
Select.

The Add Border menu appears.

4 Press  to scroll and choose a border selection.

5 Press Select.

Note: Borders are not printed when using Kodak Templates.

Adding text to your photo 

1 Press Menu until you see the Main Menu.

2 Press  until Edit Photo is highlighted, and then press Select.

or

or

or
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The Edit menu appears.

3 Press  until Add Text is highlighted, and then press Select.

The Add Text menu appears.

4 Press  to scroll and choose a text selection.

5 Press Select.

Note: Use the Modify Text option described in the following 
section to change the text selections.

Modifying text for your photo

1 Press Menu until you see the Main Menu.

2 Press  until Edit Photo is highlighted, and then press Select.

The Edit menu appears.

3 Press  until Add Text is highlighted, and then press Select.

The Add Text menu appears.

4 Press  to scroll and choose Modify Text.

The Modify Text menu appears.

5 Press  to highlight and select the text you want to modify.

6 Press Select.

7 Press , and then press Select to choose each letter or 
symbol you want.

Note: Press  until Erase Last is highlighted, and then press 
Select to erase characters, numbers, or symbols.

8 Press  to highlight Space, and then press Select to add spaces 
between text.

9 Press Done to save your text.

Notes: The letters and symbols selected appear in the text bar 
located at the bottom of the menu screen.

or

or

or

or
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Very long text messages may not print.

To set the text back to its original default settings, select 
Reset Text.

Brightness feature

To adjust the contrast of a photo, choose the Brightness feature from the 
operator panel.

1 Press Menu until you see the Main Menu.

2 Press  to highlight Edit Photo, and then press Select.

The Edit menu appears.

3 Press  to highlight Brightness, and then press Select.

4 Press  to adjust the level of brightness for your photo, and 
then press Select.

Note: Selecting the Brightness option will deactivate the Auto 
Enhance feature if previously chosen.

Auto Enhance

Use Auto Enhance to automatically improve the appearance or quality of 
your photos. 

1 Press Menu until you see the Main Menu.

2 Press  to highlight Edit Photo, and then press Select.

The Edit menu appears.

Note: Selecting Auto Enhance will deactivate the Brightness 
feature if previously chosen.

or
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3 Press  to highlight Auto Enhance, and then press Select.

4 Press  to choose from Off or On, and then press Select.

Note: Changes are applied to prints, but are not applied to the 
display image.

Resetting Defaults

Use Reset Defaults to return to your printer’s original factory settings.

1 Press Menu until you see the Main Menu.

2 Press  until Utilities is highlighted, and then press Select.

The Utility menu appears.

3 Press  until Reset Defaults is highlighted, and then press 
Select.

The Reset Defaults menu appears.

4 Press  until Yes is highlighted, and then press Select.

or
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4 Using an external Zip drive

Connecting your external Zip drive

You can copy photos from your camera card directly to a Zip drive, which is 
purchased separately. This lets you reuse your camera card and take more 
pictures. You can read photo images from these storage devices (with no 
camera card inserted).

The following external storage device is supported with your printer:

Iomega Zip™ USB attached (100 and 250MB)

To attach a Zip drive directly to your printer, see the following instructions.

Attaching your printer to the Zip drive

1 Connect the USB cable to the back of your printer and the external 
storage device.

2 Connect the power supply to the external storage device, and then 
plug it into an electrical outlet. 
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Copying photos to your Zip drive

To copy photos from the camera card to the external storage disk:

1 Insert your camera card into the appropriate slot on your printer. 
For help, see page 16.

2 Insert the storage disk into your Zip drive. 

Note: Your printer recognizes one camera card at a time. If two 
camera cards are installed, only the photos stored on the 
CompactFlash card are available. 

3 Press Menu.

4 Press the  until you see Storage, and then press Select.

The Copy and Erase options appear on the Storage menu 
screen. 

5 Make sure Copy is highlighted, and then press Select.

The Copy Card menu appears.

6 Make sure Yes is highlighted, and then press Select.

Copying Card appears with a progress bar indicating the status of 
the copy process. When the progress bar is filled, your photos 
have been copied to your external storage disk and the Storage 
menu returns.

Note: Select Cancel to stop the copy process.

7 Select View/Return to go to the Main Menu.
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Erasing photos from your camera card

After you copy your photos to an external storage disk, you can erase the 
photos from your camera card and reuse it. 

1 Insert the appropriate camera card into your printer. For help, see 
page 16.

2 Press Menu.

3 Press  until you see Storage, and then press Select.

Two options, Copy Card and Erase Card appear on the Storage 
menu screen. 

4 Press  to highlight Erase Card, and then press Select.

The Erase Card menu appears 

5 Press  to highlight Yes, and then press Select.

The Erase Card Are You Sure menu appears.

WARNING: This process erases all photos from your camera card.

6 Make sure Yes is highlighted and press Select.

Printing from your Zip disk

Remove all camera cards from your printer before printing from the 
external storage drive. The printer searches for images on the external 
storage disk only when no camera cards are installed.

To print photos from your external storage disk:

1 Load paper against the right side of the sheet feeder. For help, see 
page 4. 

Note: For best print quality, use KODAK Premium Picture Paper.

2 Insert your storage disk into your Zip drive.
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The Quick Start menu appears.

3 Select your print options, and then press Print.

Note: For the best print quality, remove each printed photo from 
the paper exit tray before the next one prints.
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Using your printer with a PC

This chapter describes how to use your printer with Windows 98/Me. 

Follow these basic steps for printing:

1 Load the paper (see page 4).

2 Customize the printer settings (see page 39).

3 Print your document (see page 42).
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Step 1: Load the paper

Load paper against the right side of the sheet feeder. For help, see page 4.

Loading other paper types

Load up to... Make sure...

10 photo cards • The print side is facing you.
• The cards are loaded vertically against the right side of 

the sheet feeder.
• The paper guide is against the side of the cards.

25 sheets of photo 
papers

• The glossy side is facing you.
• The paper guide is against the side of the photo paper.

10 transparencies • The rough side of the transparency is facing you 
(smooth side down).

• The paper guide is against the side of the 
transparencies.

100 sheets of 
custom size plain 
paper

• The print side is facing you and the paper guide is 
against the side of the paper.

• Your paper size fits within these dimensions:
- Width:

76 - 215.9 mm
3 - 8.5 in.

- Length: 
127 - 432 mm
5 - 17.0 in.

25 iron-on 
transfers

• You follow the instructions on the packaging to load the 
iron-on transfers. 

• The paper guide is against the side of the iron-on 
transfers.



39

U
sin

g
 yo

u
r p

rin
ter w

ith
 a P

C

Step 2: Customize the printer settings

Your printer software includes several applications that help you perform 
printing tasks easily. One of these applications is called Printer 
Properties. 

The Printer Properties application has three tabs: Job Finishing, Paper, 
and Document/Quality. Each tab contains settings related to the 
operation of your printer and its software.

Opening Printer Properties from an application

You can open Printer Properties from almost any application. This lets 
you change printer settings only for the document you are currently 
working on in the application. To open Printer Properties from an 
application:

1 Open the application’s File menu.

2 Choose Print (or Printer) Setup.

3 In the Printer Setup dialog box, click the Properties, Option, or 
Setup button (depending on the application).

4 Change settings as needed. For help, see page 40.

Opening Printer Properties from Windows

When you open Printer Properties from Windows, the settings you 
change apply to all documents, unless you also change them from the 
application. 

1 From the Start menu, select Settings, and then select Printers.

2 From the Printers folder, right-click the printer icon for your printer.

3 Select Properties from the sidebar menu.

Note: To help you identify Printer Properties and its associated 
tabs and functions, see page 40.
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Kodak PPM200 Printer Properties

Click the... When you want to...

Job Finishing tab • Print handouts.
• Print posters.
• Print booklets.
• Print two-sided documents.

Paper tab • Select a paper size
• Select portrait or landscape orientation.
• Set the number of copies to print.
• Reverse the printing order of your document pages. (The 

first page of your document is on top of the stack in the 
paper exit tray.)

Document Quality 
tab

• Select color settings for the document type you are 
printing.

• Choose a paper type.
• Choose a print quality setting.
• Select Web Smoothing when you are printing from the 

Internet.
• Select the default settings.

Help button • Access the printer driver Help on any tab in the Printer 
Properties.
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Choosing a Paper Type in Printer Properties

For best print quality, specify the type of paper you are using in your printer.

1 Open Printer Properties. For help, page 39.

2 Select the Document/Quality tab.

3 Select a Paper Type from the following table: 

Printing tips

• For best print quality, print with a color and photo cartridge 
combination.

• When printing photos or transparencies, remove each page as it 
exits the printer and allow it to dry before stacking.

• When printing iron-on transfers, first verify your image by printing 
on plain paper.

Printing on custom size sheets

You can print on non-standard size sheets.

1 Open Printer Properties. For help, see page 39.

2 Select the Paper tab.

3 From the list of Paper Sizes, scroll to select Custom.

4 Enter the dimensions for your custom paper. For help, see 
page 38.

Select this Paper Type: To print on this kind of paper:

KODAK Premium Picture 
Paper

Ultra glossy photo paper

Plain Paper Typical xerographic paper

Transparency Transparencies

Iron-On Transfer T-shirt transfer
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Step 3: Print your document 

1 From your application’s File menu, click Print.

2 From the Print dialog box, click OK or Print (depending on the 
application).

Understanding the Card Reader

You can use your printer to load the pictures on your camera card directly 
to your hard disk drive. 

To use the card reader from the Start-up screen:

1 Insert your camera card into the appropriate camera card slot.

2 Press  until PC Card Reader is highlighted, and then press 
Select.

3 Press  until Yes is highlighted and press Select.

The PC Card Reader Active screen appears.

To use the card reader from the Main Menu:

1 Press Menu until you see the Main Menu.

2 Press  until Utilities is highlighted, and then press Select.

3 Make sure PC Card Reader is highlighted, and then press Select.

4 Press  until Yes appears, and then press Select.

The PC Card Reader Active screen appears.

Notes: When you activate your card reader for the first time, your 
computer software detects new hardware. 

The card slots on the printer are visible as removable 
drives on your computer until you exit the card reader 
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mode from the operator panel. To exit the PC Card Reader 
mode, press Select.

The printer cannot print while in PC Card Reader mode. To 
print a photo that is on your camera card, you must first 
copy it to another location on your PC.

KODAK Picture Page Software

To install the KODAK Picture Page Software:

1 Place the CD into your computer’s CD-ROM drive.

2 Click install KODAK Picture Page Software, and then follow the 
on-screen instructions.

3 After installation is complete, restart your computer.

To open KODAK’s Picture Page Software from the Start menu, 
click:

1 Programs

2 KODAK Picture Page Software

3 Start Control Center

4 The Control Center icon in the system tray, located in the lower 
right corner of the Windows screen.

Note: All of the folders on your computer that contain pictures 
are displayed.

5 Select the Help/About tab, and then select Help to learn how to 
view, edit, and print your pictures.
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Printing beyond the basics

You can use your printer to print:

• Both sides of a sheet of paper (on this page)
• Handouts (see page 47)
• Booklets (see page 48)
• Posters (see page 50)

Printing on both sides of a sheet of paper

Your Kodak printer lets you print on both sides of a sheet of paper. Besides 
saving paper, this feature is helpful when you want to print booklets or 
tablets.

Note: This feature does not work with all paper types. Be sure to 
check if your paper supports two-sided printing.

Step 1: Load the paper

Load paper against the right side of the sheet feeder. For help, see page 4.

Step 2: Customize Printer Properties for your two-sided 
print job 

1 Open Printer Properties. For help, see page 39.

2 Select the page orientation and size:

a Click the Paper tab.

b Select the appropriate Paper Size.



46

P
ri

n
ti

n
g

 b
ey

o
n

d
 t

h
e 

b
as

ic
s

c Select Portrait or Landscape orientation.

3 Customize the Printer Properties for two-sided printing:

a Click the Job Finishing tab.

b Select Two-sided printing.

c Select a binding edge. 

Note: To print paper reloading instructions, select Print 
reloading instructions after the first side prints.

4 Click OK.

Step 3: Print your two-sided document

1 From your application’s File menu, select Print. The 
odd-numbered pages print first. 

2 When the first side of all your two-sided document is finished 
printing, your printer software prompts you to reload the paper.

3 Click OK. The even-numbered pages print on the other side of the 
stack.

To return to single-sided printing:

1 From the Printer Properties, click the Job Finishing tab.

2 Make sure Two-sided printing is not selected.

3 Click OK.

a Remove the stack 
of paper from the 
exit tray.

b Flip the stack.

c Insert the stack of 
paper and 
instruction page 
with the printed 
side facing away 
from you and the 
arrows pointing 
down.
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Printing handouts

You can conserve paper by printing handouts or multiple page images on a 
single sheet of paper. 

Step 1: Load the paper 

Load paper against the right side of the sheet feeder. For help, see page 4.

Step 2: Customize Printer Properties for handouts

You can print your handouts on one side of the paper or on both sides.

1 Open Printer Properties. For help, see page 39.

2 Select the page orientation for the page images.

The page orientation you select in the Paper tab reflects the 
orientation of the page image and not the sheet of paper the page 
image prints on. 

a Click the Paper tab.

b From the Orientation area, select Portrait or Landscape.

3 From the Paper Size area, select a paper size. 

4 Click the Job Finishing tab and select the following options:

a Select Handout.

b Select the Number of Prints (page images) to print on a 
single sheet.

c To print a representation of the paper edges for each page 
image, select Print Page Borders.

5 To print your handout on one side of the paper, click OK. To print 
your handout on both sides of the paper:

a Select Two-sided printing.
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b To print paper reloading instructions, select Print reloading 
instructions after the first side prints. 

c Click Long Edge Binding or Short Edge Binding.

d Click OK.

Step 3: Print your handouts

1 From your application’s File menu, select Print.

2 From the Print dialog box, click OK or Print (depending on the 
application).

– If you formatted your handouts to print on one side of each 
page, go to step 3.

– If you formatted your handouts for two-sided printing, continue 
with printing the second side of your handouts.

3 When the first side of all your handouts is finished printing, your 
printer software prompts you to reload the paper. 

Note: For help reloading and printing two-sided pages for your 
booklet, see page 46.

To return to normal printing: 

1 From the Job Finishing tab, select Normal.

2 Make sure Two-sided printing is not selected.

3 Click OK.

Printing booklets

You can print and bundle your document together to make a booklet.

Step 1: Load the paper 

Load paper against the right side of the sheet feeder. For help, see page 4.
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Step 2: Customize Printer Properties for booklets

1 Select the correct paper size in your software application.

You can select from these paper sizes when printing booklets:

– Statement
– Letter
– A4
– A5

2 Open the Printer Properties. For help, see page 39.

3 Click the Job Finishing tab.

4 Select Booklet.

5 To print paper reloading instructions, click Print reloading 
instructions after the first side prints. 

6 Select the number of Sheets Per Bundle. 

Note: A bundle is any number of sheets of paper folded together. 
When printing with a heavier paper stock, select a smaller 
number of Sheets Per Bundle to allow for binding 
considerations.

7 Click OK.

Step 3: Print and assemble your booklet

1 From your application’s File menu, select Print.

2 From the Print dialog box, click OK or Print (depending on the 
application).

3 When the first side of your booklet is finished printing, your printer 
software prompts you to reload the paper.

Note: For help reloading and printing two-sided pages for your 
booklet, see page 46.

4 Click OK. The even-numbered pages print on the other side.
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To return to normal printing:

1 From the Job Finishing tab, select Normal.

2 Click OK.

3 Assemble your booklet. For help, see the following section.

Building a booklet

1 Take the first bundle from the paper exit tray, fold it in half, and set it 
aside.

2 Fold and stack the rest of your bundles, one on top of the other, 
until your booklet is complete.

3 Bind the bundles together.

Printing posters

You can use the printer software to enlarge your printout to a 4, 9, or 16 
page poster.

Note: The poster finishing option is designed to print a 
single-page as a 4, 9, or 16 page poster. 

Step 1: Load the paper

Load paper against the right side of the sheet feeder. For help, page 4.

Note: For the best print quality, use a heavy paper. 
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Step 2: Customize Printer Properties for your poster

1 Open Printer Properties. For help, see page 39.

2 Click the Job Finishing tab.

3 Select Poster.

4 Select your poster size.

The number you select represents the number of pages that make 
up the height and width of your poster. For example, if you select
4 x 4, your printed poster is four pages high and four pages wide. 

5 Select Show Crop Marks if you want to print markers that show 
you where to easily trim (crop) the unprinted white space from the 
edges of the paper.

6 Click OK.

Step 3: Print and assemble your poster

1 From your application’s File menu, select Print.

2 From the Print dialog box, click OK or Print (depending on the 
application).

Note: If you need to reprint a specific page of your poster, see 
page 52.

3 On each printed page, trim the white edges from two adjacent 
sides.
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For example, trim the white edge from the top and left sides of 
each page. 

4 Arrange the pages so that every trimmed edge overlaps an 
untrimmed white edge.

5 Tape the backs of the pages together.

6 To complete your poster, trim any remaining white edges.

Selecting specific pages to print 

You can reprint specific pages of your poster without having to reprint all of 
them. 

1 From the Job Finishing tab, click Select Pages to Print.

2 From the Select Pages to Print screen:

a Click Select All to select all the tiles, and then click the tiles 
you do not want to print.

b To quickly select a few tiles to print, click Remove All to 
remove all the tiles, and then click the tiles you want to print.

c Click OK.

3 Print your poster pages.

4 Assemble your poster. For help, see page 51.

5 To return to regular printing:

a From the Job Finishing tab, select Normal.

b Click OK.
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7 Caring for your cartridges

This chapter describes how to perform cartridge maintenance. You can 
install or replace cartridges, view ink levels, clean and align cartridges 
using your computer, or printer’s operator panel. If your printer is 
connected to a computer, it may be more convenient to do these 
operations from your computer.

Using your computer for cartridge maintenance

To perform cartridge maintenance from your computer, you must access 
the Control Program.

To open the Control Program from the Start menu, click:

1 Programs

2 KODAK PPM200 

3 KODAK PPM200 Control Program
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KODAK PPM200 Control Program

Note: You can also access the Control Program by double- 
clicking the KODAK PPM200 icon on your desktop.

Installing or replacing print cartridges

1 Raise the front cover. The print cartridge carrier moves to the 
loading position unless the printer is busy.  

Click the... When you want to...

Status tab • Monitor the status of your print job.
• Cancel your print job.
• Print a test page. 
• View your ink levels.

Options tab Enable/disable various printer software functions, such as 
Sound Effects and Buffer Mode.

Cartridges tab • Install or replace print cartridges.
• Clean the print nozzles.
• Align print cartridges for best print quality.
• View cartridge part numbers and order supplies directly 

from Kodak’s Web site.

About tab Find the printer software version and copyright notice.

Help button Access the printer driver Help on any tab in the Control 
Program.

Print cartridge 
carrier in the 
loading position

Front 
cover
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2 Remove the old print cartridge. Store it in an air-tight container or 
dispose of it. 

3 Match the cartridge cap color to the cartridge carrier color and 
install the cartridge in the printer:

Note: For the best possible photo quality, replace the black 
cartridge with a photo cartridge and print with a photo and 
color cartridge combination. 

4 Close the front cover.

5 From the Control Program’s Cartridges tab, select Install/Change 
Cartridge. 

6 Select the type of cartridge you installed and click OK.

7 If you installed a new cartridge, the Alignment dialog box displays. 
Follow the instructions on the Alignment screen to complete the 
cartridge installation. For help, see the next section.

Photo cartridge
CAT 175 4852

Color cartridge
CAT 195 1730

Black cartridge
CAT 136 9511

Push back firmly 
on the cartridge 
until it snaps 
securely into 
place.

Insert the print 
cartridge into the 
print cartridge 
carrier.

If you are installing a 
new cartridge, remove 
only the sticker and the 
transparent tape from 
the bottom of the print 
cartridge.

a b c

Snap
WARNING: 
DO NOT 
touch the 
gold contact 
area of the 
print cartridge.
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Aligning print cartridges

If the print quality is not satisfactory, a simple cartridge alignment may 
improve print quality. If print quality is still not satisfactory after aligning the 
print cartridges, you may need to clean the print nozzles.

1 Load plain paper in the printer. For help loading paper, see page 4.

2 From the Control Program’s Cartridges tab, select Align 
Cartridges.

Your printer prints an alignment test page and the Align Cartridge 
dialog box is displayed. 

The test page prints several alignment patterns, depending on the 
cartridge combination installed. Each pattern has a number under 
it. The test page that prints is similar to the one shown:

3 From each alignment group on the test page, find the number 
under the alignment pattern that comes closest to forming a 
straight line.

For example, in sample group A, the arrow points to the pattern 
that comes closest to forming a straight line.

4 In the Align Cartridges dialog box, enter the pattern numbers 
from the printed test page that come closest to forming a straight 
line.

5 After you have entered a number for all of the patterns, click OK.

Note: If you have a color and 
black cartridge combination 
installed, you will have two more 
alignment values, C and D. 
Follow the same instructions as 
you would for the color and 
photo cartridge combinations.
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Cleaning print nozzles

1 Load plain paper in the printer.

2 From the Control Program’s Cartridges tab, select Clean Print 
Nozzles.

The printer feeds a sheet of paper and prints a nozzle test pattern 
similar to the one shown:

3 Compare the diagonal line above the printed bars to the diagonal 
line below the printed bars.

Look for a break in the diagonal lines above the printed bars. A 
broken line indicates clogged nozzles. 

If the bottom line still has breaks, run the test up to two more times. 

– If the print quality is satisfactory after running the test three 
times, the print nozzles are clean. You do not need to 
complete the remaining steps.

– If the print quality of both lines is not satisfactory after running 
the test three times, continue with step 4.

4 Remove and reinstall the print cartridge. 

5 Repeat the nozzle test. 

6 If the lines are still broken, wipe the print cartridge nozzles. For 
help, see “Wiping print nozzles and contacts” on page 59.

Broken lines at the top 
of the page indicate 
clogged nozzles.

Unbroken lines at the 
bottom of the page 
indicate the nozzles 
were cleaned.

Cyan, magenta, 
yellow, and 
black solid lines 
(shown here in 
black and white) 
print when ink is 
forced through 
the print 
nozzles to 
unclog them. 
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Using your operator panel for cartridge 
maintenance

Installing or Replacing Print Cartridges

1 Install or replace your print cartridges. For help, follow steps 1 
through 4, beginning on page 54.

When you begin a print job, the printer will ask you to select the 
type of cartridges installed.

2 Select the correct option and press Select.

Note: If you installed new cartridges, the printer will ask if you 
want to align them. To align the print cartridges, insert a 
sheet of plain paper, choose Yes from the operator panel, 
and then press Select.

3 Follow the alignment process on page 5.

Aligning the Print Cartridges

See page 5.

Cleaning print nozzles

1 Press Menu until you see the Main Menu.

2 Press  until Utilities is highlighted, and then press Select.

The Utilities menu appears.

3 Press  until Clean Cartridge is highlighted, and then press 
Select.

The Clean Cartridge menu appears.

4 Press  until Yes is highlighted, and then press Select.
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The Cleaning Cartridge menu appears with a progress bar 
showing the status of the cleaning process. When the progress bar 
is complete, the Utilities menu returns.

Note: The printer feeds a sheet of paper and prints a nozzle test 
pattern similar to the one shown on page 57.

5 Follow steps 3 through 5 on page 57.

6 If the lines are still broken, wipe the print cartridge nozzles. For 
help, see “Wiping print nozzles and contacts” on page 59.

7 Press Print to begin printing or use the View/Return button to go 
to other menu options.

Viewing ink levels from the operator panel

1 Press Menu until you see the Main Menu.

2 Press  until Utilities is highlighted, and then press Select.

The Utilities menu appears.

3 Make sure Ink Level is highlighted, and then press Select.

The Ink Level menu appears.

4 View the ink level. 

5 Select Done when you are finished checking the ink level.

Cleaning and preserving print cartridges

Wiping print nozzles and contacts

If print quality does not improve after cleaning the print nozzles, there may 
be dried ink on the print cartridge nozzles or the print cartridge contacts. 

To wipe the print cartridge nozzles and contacts:

1 Remove the print cartridge from your printer. For help, see 
page 54.
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2 Dampen a clean lint-free cloth with water and gently wipe the 
entire gold-colored area, including the nozzles.

WARNING: Wipe the nozzles in one direction so the colors do not 
mix.

3 To dissolve dried ink, hold the damp cloth against the nozzles for 
about three seconds. Gently blot and wipe dry.

4 Dampen another section of clean, lint-free cloth with water and 
gently wipe the entire gold-colored area, including the contacts. 

WARNING: When cleaning the print cartridge, wipe the contacts in 
one direction.

5 To dissolve dried ink, hold the damp cloth against the contacts for 
about three seconds. Gently blot and wipe dry. Allow the 
gold-colored areas to dry before you reinsert the cartridge into 
your printer.

Reinstall the print cartridge and repeat the nozzle test. For help, see 
page 57.

Nozzles

Contacts
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Preserving print cartridges

To ensure the longest life from your print cartridge and optimum 
performance from your printer:

• Keep a new print cartridge in its packaging until you are ready to 
install it.

• If a print cartridge runs out of ink, leave the empty cartridge in the 
printer until you are ready to replace it. Printing with one of the 
print cartridge carriers empty may cause printer problems.

• Do not remove a print cartridge from the printer except to replace, 
clean, or store it in an air-tight container. The print cartridge does 
not print correctly if removed from the printer and left exposed for 
an extended period of time.

The printer warranty does not cover repair of failures or damage caused by 
a refilled cartridge. Kodak does not recommend use of refilled cartridges. 
Refilling cartridges can affect print quality and cause damage to the printer. 
For best results, use Kodak supplies.
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Troubleshooting

Understanding the operator panel error 
messages

Cannot read Card

Check your camera card. The card may not have photos on it or it may be 
damaged.

Carrier Stall

The cartridge carrier inside your printer has stalled. Unplug your printer, 
clear the paper jam, and then plug your printer back in. For help clearing 
paper jams, see page 65.

Copy Failed Disk Full

Your external storage disk is full. Insert a new disk to store additional 
photos. 

Copy Failed, Write Protected

The external storage disk you are using is write protected. You must 
remove write protect from your disk before you copy photos.
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Copy Failed No Disk

Your printer does not recognize your external storage drive. Check your 
external storage drive cable connections to make sure they are secure. 

Decode Error 

Your printer can’t read your camera card. This is often caused by removing 
your camera card from your camera before it has finished storing the 
image. It can also be caused by photos that have been previously 
uploaded to a computer and modified. 

Note: If the printer is connected to a computer, try viewing your 
photos from the card reader mode. For help using the card 
reader, see page 42.

Erase Failed

The photos cannot be erased from your disk. Make sure your disk is not 
write protected.

Insert Paper, Press Print

The printer is out of paper. For help loading paper, see page 4.

Install Cartridge

Install a cartridge. For more information, see page 2.

Low Ink

Check your ink levels, it may be time to replace a cartridge. To check your 
ink levels from your computer, see page 54. To view your ink levels from 
your printer’s display, see page 59.
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No PC is Connected

This error message appears when you choose the Card Reader option 
from the operator panel and no computer is connected. Card Reader is a 
function that interacts with your computer. For help, see “Understanding 
the Card Reader” on page 42.

Paper Jam

Try removing the paper from the sheet feeder. If the paper is lodged too far 
into the printer and can’t be removed:

1 Unplug your printer.

2 Pull firmly on the paper to remove it. If you cannot reach the paper 
because it is too far into the printer, raise the front cover and pull 
the paper out.

3 Close the front cover.

4 Plug your printer into an electrical outlet.

Resend your document to print.

Printing problems without a computer

My printer will not read my camera card

• Remove your camera card for 15 seconds, and then reinsert.
• There may not be any photos on your camera card.
• Your camera card may not be supported by your printer.

The colors on my printed photos do not appear correctly

• Your cartridge may be running out of ink and you may need to 
replace your print cartridge. For help, see page 54.

• Check your paper. Photos can print with color variations 
depending upon the type of paper you have loaded in your printer. 
For the best print results, use KODAK Premium Picture Paper.
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Printed pages have alternating bands of light and dark 
print (intermittent printing)

Select Best print quality setting from your printer’s operator panel. 
For help, see page 24.

My photo prints, but there is too much white space on the 
paper

• Make sure the paper size selected under PRINT OPTIONS 
matches the paper size loaded in your printer. For help selecting 
the correct paper size, see page 23.

• You may not have selected enough photos to print on one page. 
For help, see “Choosing the page layout” on page 24.

Printer prints very slowly

Select a lower print quality setting.

Note: If you are printing photos or your document contains 
graphics, it may take longer to print than regular text.
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Printing problems with your computer

When your printer has a problem, first make sure that:

• The power supply is plugged into the printer and a properly 
grounded electrical outlet.

• The printer USB cable is securely attached to your computer and 
printer.

Printer prints very slowly

• Close any open applications not in use.
• Select a lower print quality setting.
• Consider purchasing more memory, or increasing the virtual 

memory for your computer.

Note: If you are printing photos or your document contains 
graphics, it may take longer to print than regular text.

Printer is plugged in but doesn’t print, or you get a Printer 
Offline message

Make sure:

• The printer is on and the paper is loaded correctly.
• The USB cable is completely plugged into the printer.
• The printer is set as the default printer.
• The printer is not set up as a card reader. For help, see page 42.
• The print job is not being held or paused in the print queue. 

To check the printer status in Windows:

1 From the Printers folder, double-click the KODAK PPM200 icon.

2 Click the Printer menu and make sure no check mark appears 
next to the Pause Printing option.

If these steps have not corrected the problem:

1 Turn off your computer.
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2 Unplug the USB cable from the back of your printer.

3 Unplug your printer from the electrical outlet and wait 
approximately15 seconds

4 Plug your printer back in.

5 Reconnect the USB cable to the back of your printer.

6 Turn your computer back on.

Test page does not print

Make sure:

• You have removed the tape from the cartridges. For help, see 
page 2.

• Your print cartridges are properly installed. For help, see page 2.
• The printer is set as the default printer.

Printed pages have alternating bands of light and dark 
print (intermittent printing)

• Make sure Enable Buffer Mode is checked on the Options tab of 
the Control Program for Windows.

• Select the High 1200 x 1200 dpi Print Quality setting on the 
Document Quality tab of the Printer Properties.

The printer settings I selected changed

When you change printer settings from your application, the 
settings apply only to the specific document you opened with that 
application. To make the settings apply to all documents, see 
page 39.

Transparencies or photos contain white lines

• Select the High Quality 1200dpi setting.
• Your print nozzles may need cleaning. For help, see page 57.



69

Tro
u

b
lesh

o
o

tin
g

General printing problems with or without your 
computer

Printer ejects a blank page after appearing to print 

Make sure you have removed the sticker and transparent tape covering the 
gold area on the print cartridges. For help, see page 2.

Paper misfeeds or pulls multiple sheets through the 
printer 

Make sure:

• You are using a paper recommended for inkjet printers.
• You do not force the paper down into the printer when you load it. 
• You do not load too much paper in the sheet feeder. Depending on 

the thickness of your paper, the sheet feeder can hold up to 100 
sheets of plain paper or 25 sheets of KODAK’s Premium Picture 
Paper.

• The left paper guide does not cause the paper to bow in the sheet 
feeder.

• The printer is on a flat, level surface.

Printer has a paper jam

See page 65.

Vertical straight lines are not smooth

To improve the print quality of vertical straight lines in tables, borders, and 
graphs:

• Test the cartridge alignment. For help, see page 5 or 56.
• Select a higher Print Quality setting. For help, see page 24 and 

40. 
• Clean the print nozzles. For help, see page 57 or 58.
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Print is too dark or smudged

Make sure:

• You let the ink dry before handling the paper.
• The Paper Type setting matches the paper type loaded in the 

printer.
• The paper is straight and unwrinkled.
• The print quality setting is appropriate for the paper type. If you are 

printing on regular paper and have a color and black cartridge 
combination installed, select the Draft 300 x 600 dpi Print Quality 
setting.

Notes: The Draft 300 x 600 dpi Print Quality option will not be 
available when you install a color and photo cartridge 
combination.

If print quality still has not improved, you may need to 
clean the print nozzles. For help, see page 57 or 58.

Colors are not printing correctly

• Your print cartridge may be low on ink. Check the ink level graphic 
on the Cartridges tab of your printer’s Control Program, or the 
printer’s operator panel menu. For help, see pages 54 and 59.

• Use a different brand of paper. Every paper brand accepts ink 
differently and prints with slight color variations. For best print 
results, use KODAK Premium Picture Paper.

• Clean the print nozzles. For help, see page 57 or 58.

Glossy photo papers or transparencies stick together

• Remove each page as it exits the printer and allow it to dry before 
stacking.

• Use a transparency or photo paper designed for an inkjet printer.
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KODAK Customer Support Center

Prior to contacting Kodak, please have the following information available 
so we may serve you faster. (Located on the back of the printer.)

Machine Type number

Serial number

Date purchased

Store where purchased

United States and Canada 

1-877-774-6837

Or you may contact Kodak through our Web 
site:www.kodak.com/go/homeprinting

Support Center Hours of Operation:

9 AM-9 PM Monday through Friday and 
12 PM-6 PM Saturday and Sunday (Eastern Time).
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Appendix

In this section, you can find 
information about:

• Installing printer software
• Uninstalling printer 

software
• Warranty
• Notices
• Safety

Installing printer 
software
You can obtain the printer 
software using the:

• Compact disc (CD-ROM) 
that came with your 
printer 

• World Wide Web

If your printer software does 
not install properly, a 
communications error 
message appears when you 
try to print. You may need to 
uninstall, and then reinstall 
the printer software. For help 
see Uninstalling printer 
software. For help installing 
your software, see page 6.

Using the World Wide 
Web
If your computer does not 
have a CD-ROM drive, you 
can download the printer 
software from the World 

Wide Web at http://
www.kodak.com/go/
ppm200.

1 At KODAK’s Web site, 
select the appropriate 
driver for your operating 
system.

2 Select Save to Disk.

3 Download according to 
your operating system 
requirements.

Uninstalling 
printer software 
for Windows
If your printer software does 
not install properly, or your 
printer is not installed to the 
correct port, you may need 
to uninstall, and then 
reinstall the software.

To uninstall the printer 
software:

1 From the Start menu, 
select Programs.

2 Select KODAK PPM200.

3 Select KODAK PPM200 
Uninstall.

4 Follow the instructions on 
your screen.

To reinstall the printer 
software, follow the 
appropriate set of 
instructions from “Installing 
printer software.”

Uninstalling 
printer software 
for Macintosh
If your printer software does 
not install properly, you may 
need to uninstall and 
reinstall the software.
To uninstall the printer 
software:
1 Drag the printer icon to 

the trash can on the 
desktop.

2 Insert the software CD.

The KODAK PPM200 
Installer screen appears.

3 Click Install and Agree.

4 From the Easy Install 
pop-up menu, choose 
Uninstall.

5 Select Complete 
Uninstall.

6 Click Uninstall.
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Statement of 
Limited Warranty 
Lexmark International, Inc., 
Lexington, KY

This warranty applies to the 
United States and Canada. 
For customers outside the 
U.S. and Canada, refer to 
the country-specific warranty 
information that came with 
your printer. 

KODAK Personal Picture 
Maker 200by Lexmark

This Statement of Limited 
Warranty applies to this 
product if it was originally 
purchased for your use, and 
not for resale, from Lexmark 
or a Lexmark remarketer 
including KODAK, referred 
to in this statement as 
“Remarketer.” 

Warranty 
Lexmark warrants that this 
product:

• Is manufactured from new 
parts, or new and 
serviceable used parts, 
which perform like new 
parts,

• Is free from defects in 
material and 
workmanship,

• Conforms to Lexmark’s 
official published 
specifications, and

• Is in good working order.

If this product does not 
function as warranted during 
the warranty period, contact 
a Remarketer or Lexmark for 
repair without charge.

If you transfer this product to 
another user, warranty 
service under the terms of 

this statement is available to 
that user for the remainder of 
the warranty period. You 
should transfer proof of 
original purchase and this 
statement to that user.

Warranty Service
The warranty period is 12 
months and starts on the 
date of original purchase as 
shown on the purchase 
receipt.

To obtain warranty service 
you may be required to 
present proof of original 
purchase. Warranty service 
will be provided at a 
Lexmark designated 
location.

When warranty service 
involves the exchange of a 
product or part, the item 
replaced becomes the 
property of the Remarketer 
or Lexmark. The 
replacement may be a new 
or repaired item. The 
replacement item assumes 
the remaining warranty 
period of the original 
product.

Replacement is not available 
to you if the product you 
present for exchange is 
defaced, altered, in need of 
a repair not included in 
warranty service, or 
damaged beyond repair. 
Also, such product must be 
free of any legal obligation or 
restrictions that prevent its 
exchange.

Before you present this 
product for warranty service, 
remove all programs, data, 
and removable storage 
media.

For further explanation of 
your warranty alternatives 
and the nearest Lexmark 
authorized servicer in your 
area, please call 
1-888-774-6837.

Free remote technical 
support is provided for this 
product throughout its 
warranty period. Lexmark 
offers a variety of extended 
warranty programs that 
include an extension of 
technical support. For 
products no longer covered 
by a Lexmark warranty, 
technical support may only 
be available for a fee.

Extent of Warranty
Lexmark does not warrant 
uninterrupted or error-free 
operation of a product.

Warranty service does not 
include repair of failures 
caused by:

• Modification or 
attachments

• Accidents or misuse
• Unsuitable physical or 

operating environment
• Maintenance by anyone 

other than Lexmark or a 
Lexmark authorized 
servicer

• Operation of a product 
beyond the limit of its duty 
cycle

• Failure to have installed a 
maintenance kit as 
specified (if applicable)

• Use of printing media 
outside of Lexmark’s 
published specifications
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• Use of other than 
KODAK’s inkjet cartridges 
manufactured by 
Lexmark

• Use of other than 
Lexmark provided 
product or component

ALL EXPRESS AND 
IMPLIED WARRANTIES, 
INCLUDING THE IMPLIED 
WARRANTIES OF 
MERCHANTABILITY AND 
FITNESS FOR A 
PARTICULAR PURPOSE, 
ARE LIMITED IN 
DURATION TO THE 
WARRANTY PERIOD. NO 
WARRANTIES, EXPRESS 
OR IMPLIED, WILL APPLY 
AFTER THIS PERIOD.

KODAK DISCLAIMS ALL 
WARRANTIES, EITHER 
EXPRESSED OR IMPLIED.

Limitation of Liability
Your sole remedy under this 
Statement of Limited 
Warranty is set forth in this 
section. For any claim 
concerning performance or 
nonperformance of Lexmark 
or a Remarketer for this 
product under this Statement 
of Limited Warranty, you 
may recover actual damages 
up to the limit set forth in the 
following paragraph.

Lexmark's liability for actual 
damages from any cause 
whatsoever will be limited to 
the greater of 1) $5,000 or 2) 
the amount you paid for the 
product that caused the 
damages. This limitation of 
liability will not apply to 
claims by you for bodily 
injury or damage to real 
property or tangible personal 
property for which Lexmark 

is legally liable. IN NO 
EVENT WILL LEXMARK 
OR REMARKETER BE 
LIABLE FOR ANY LOST 
PROFITS, LOST SAVINGS, 
INDIRECT OR 
INCIDENTAL DAMAGES, 
OR OTHER ECONOMIC 
CONSEQENTIAL 
DAMAGES. This is true 
even if you advise Lexmark 
or a Remarketer of the 
possibility of such damages. 
Lexmark is not liable for any 
claim by you based on a 
third party claim. 

This limitation of remedies 
also applies to any 
developer of materials 
supplied to Lexmark. 
Lexmark’s and the 
developer’s limitations of 
remedies are not cumulative. 
Such developer is an 
intended beneficiary of this 
limitation. 

Additional Rights
Some states do not allow 
limitations on how long an 
implied warranty lasts, or do 
not allow the exclusion or 
limitation of incidental or 
consequential damages. If 
such laws apply, the 
limitations or exclusions 
contained in this statement 
may not apply to you.

This warranty gives you 
specific legal rights. You 
may also have other rights 
which vary from state to 
state.

Electronic 
emission notices

Federal 
Communications 
Commission (FCC) 
Compliance 
Information 
Statement
The KODAK Personal 
Picture Maker 200 by 
Lexmark, Type 4103-P01 
has been tested and found 
to comply with the limits for a 
Class B digital device, 
pursuant to Part 15 of the 
FCC Rules. Operation is 
subject to the following two 
conditions: (1) this device 
may not cause harmful 
interference, and (2) this 
device must accept any 
interference received, 
including interference that 
may cause undesired 
operation.

The FCC Class B limits are 
designed to provide 
reasonable protection 
against harmful interference 
in a residential installation. 
This equipment generates, 
uses and can radiate radio 
frequency energy and, if not 
installed and used in 
accordance with the 
instructions, may cause 
harmful interference to radio 
communications. However, 
there is no guarantee that 
interference will not occur in 
a particular installation. If 
this equipment does cause 
harmful interference to radio 
or television reception, which 
can be determined by 
turning the equipment off 
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and on, the user is 
encouraged to try to correct 
the interference by one or 
more of the following 
measures:

• Reorient or relocate the 
receiving antenna.

• Increase the separation 
between the equipment 
and receiver.

• Connect the equipment 
into an outlet on a circuit 
different from that to 
which the receiver is 
connected.

• Consult your point of 
purchase or service 
representative for 
additional suggestions.

The manufacturer is not 
responsible for any radio or 
television interference 
caused by using other than 
recommended cables or by 
unauthorized changes or 
modifications to this 
equipment. Unauthorized 
changes or modifications 
could void the user's 
authority to operate this 
equipment.

To assure compliance with 
FCC regulations on 
electromagnetic interference 
for a Class B computing 
device, use a properly 
shielded and grounded cable 
such as Lexmark part 
number 43H5856 for USB 
attach. Use of a substitute 
cable not properly shielded 
and grounded may result in 
a violation of FCC 
regulations.

Any questions regarding this 
compliance information 
statement should be directed 
to: 

Director of Lab Operations
Lexmark International, Inc.
740 West New Circle Road 
Lexington, KY 40550
(859) 232-3000

Notices

Industry Canada 
Compliance 
Statement 
This Class B digital 
apparatus meets all 
requirements of the 
Canadian 
Interference-Causing 
Equipment Regulations.

Avis de conformité 
aux normes 
d’Industrie Canada
Cet appareil numérique de la 
classe B respecte toutes les 
exigences du Règlement sur 
le matériel brouilleur du 
Canada.

European 
Community (EC) 
directives 
conformity 
This product is in conformity 
with the protection 
requirements of EC Council 
directives 89/336/EEC and 
73/23/EEC on the 
approximation and 
harmonization of the laws of 
the Member States relating 
to electromagnetic 
compatibility and safety of 

electrical equipment 
designed for use within 
certain voltage limits. 

A declaration of conformity 
with the requirements of the 
Directive has been signed by 
the Director of 
Manufacturing and 
Technical Support, Lexmark 
International, S.A., Boigny, 
France. 

This product satisfies the 
Class B limits of EN 55022 
and safety requirements of 
EN 60950.

Japanese VCCI 
notice 

The United Kingdom 
Telecommunications 
Act 1984 
This apparatus is approved 
under the approval number 
NS/G/1234/J/100003 for the 
indirect connections to the 
public telecommunications 
systems in the United 
Kingdom.

Energy Star
The EPA ENERGY STAR 
Computers program is a 
partnership effort with 
computer manufacturers to 
promote the introduction of 
energy-efficient products 
and to reduce air pollution 
caused by power generation.

Companies participating in 
this program introduce 
personal computers, 
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printers, monitors, or fax 
machines that power down 
when they are not being 
used. This feature will cut 
the energy used by up to 50 
percent. Lexmark is proud to 
be a participant in this 
program.

As an Energy Star Partner, 
Lexmark International, Inc. 
has determined that this 
product meets the Energy 
Star guidelines for energy 
efficiency.

Power Supply 
information 
If your power supply fails, 
replace it with the Lexmark 
replacement part.

Safety 
information
• If your product is NOT 

marked with this symbol 
, it MUST be 

connected to an electrical 
outlet that is properly 
grounded.

• The power supply must 
be connected to an 
electrical outlet that is 
near the product and 
easily accessible.

• Refer service or repairs, 
other than those 
described in the 
operating instructions, to 
a professional service 
person.

• This product is designed, 
tested and approved to 
meet strict global safety 
standards with the use of 
specific Lexmark 
components. The safety 
features of some parts 
may not always be 
obvious. Lexmark is not 
responsible for the use of 
other replacement parts. 
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Index

A
About tab 54
aligning print cartridges 

5, 56
Arrow button

locating 15
using 15

Auto Enhance 31

B
banding 66, 68
binding options

long edge 48
short edge 48

booklets
building 50
bundling 50
printing 48

borderless prints 26
borders, adding 29
brightness control

locating 15
using 15

brightness feature 31
buttons, operator panel 

15

C
cable

connections 14
USB 14

camera card
choosing 16
cover 13
erasing photos 35
inserting 16
slot, locating 16

camera compatibility, 
verifying 15

camera order, print 17, 
27

camera, compatibility list 
15

captions, adding 29
card reader, PC 17, 42
Cartridges tab 54
cartridges, print

aligning 5, 56
cleaning 59
gold contact area 2
installing 2, 54
preserving 61
removing 54
replacing 54

colors, wrong 65
compatibility list, camera 

15
connecting

external device 14
Power supply 14
USB cable 6
USB/PC 14

Control Program 54
About tab 54
Cartridges tab 54

Help button 54
Options tab 54
Status tab 54

Copy Failed Disk Full 63
Copy Failed Write 

Protected 63
copying photos 34
cover, camera card 13
crop marks, selecting 51
crop photos, using 27
custom size paper, 

loading 38
customer support 71

D
Decode Error 64
defaults

factory, resetting 32
Display window

locating 15
using 15

Document Quality tab 40
downloaded printer 

driver, installing 73
duplexing 45

E
electronic emission 

notices 75
erasing photos 35
error messages

Cannot read Card 63
Carrier Stall 63
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Copy Failed Disk Full 
63

Copy Failed No Disk 
64

Copy Failed, Write 
Protected 63

Decode Error 64
Erase Failed 64
Printer Offline 67

exit tray
locating 13
using 13

external storage device
connecting 14, 33

F
factory defaults, resetting 

32
FCC statement 75
frames, adding to a photo 

29
front cover

locating 13
using 13

H
handouts, printing 47
Help button 40, 54
help, technical support 

71

I
idle screen 18
index, printing 17, 27
Industry Canada 

Compliance Statement 
76

ink levels, viewing 54, 59
installing

print cartridge 54
printer software 6, 9, 

10, 11, 43, 73

installing, KOKAK Picture 
Page Software 43

intermittent printing 66, 
68

iron-on transfers, loading 
38

J
Japanese VCCI notice 

76
Job Finishing tab 40

K
KODAK Picture Page 

Software, installing 43
Kodak templates 25

L
languages, changing 18
layout

changing 17
choosing 24

loading paper 4
long edge binding 48

M
Macintosh, printer setup 

10
main menu

understanding 21
using 21

Menu buttons
locating 15
using 15

messages, error
Cannot read Card 63
Carrier Stall 63
Copy Failed Disk Full 

63
Copy Failed No Disk 

64
Copy Failed, Write 

Protected 63
Decode Error 64
Erase Failed 64
Printer Offline 67

N
notices

electronic emission 75
European Community 

directives conformity 
76

FCC 75
Industry Canada 

Compliance 
Statement 76

Japanese VCCI notice 
76

United Kingdom 
Telecommunications 
Act 1984 76

nozzles, print
cleaning 57, 58
wiping 59

O
operator panel

buttons 13
error messages 63
using 13

Options tab 54
ordering replacement, 

power supply 77

P
page layout, choosing 24
Panoramic 25
paper

choosing 22
loading 4
size, choosing 23
types 22
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paper exit tray
locating 4, 13
using 4, 13

paper feeder
See sheet feeder

paper guide 13
paper support 13
Paper tab 40
part number, USB cable 

76
PC card reader 17, 42
photo and print preview, 

using 18
photo cards, loading 38
photo paper, problems 

70
photo papers, loading 38
photos

adding frames 29
adding text 29
auto enhance 31
brightness 31
colors wrong 65
copying to zip drive 34
cropping 28
editing 27
erasing from the 

camera card 35
layout, choosing 17, 

24
modifying text 30
rotating 28
selecting 26
storing 34
viewing 17

photos to print option, 
using 26

poster
assembling 51
printing 50
selecting specific 

pages 52
power connection 14

power supply 77
connecting 1
ordering replacement 

77
print all photos 17
Print button

locating 15
using 15

print cartridges
aligning 5, 56
contacts, cleaning 59
gold contact area 2
installing 2, 54
preserving 61
removing 54
replacing 54

print nozzles 59
cleaning 57, 58
wiping 59

print quality
banding 66, 68
changing 24
different colors 70
missing colors 70
smudged 70
too dark 70

Print Sizes 25
printer driver

downloading 73
installing 73
uninstalling 73

printer driver Help, 
accessing 40, 54

printer parts
locating 13
using 13

Printer Properties
customizing 39

for booklets 49
for handouts 47
for poster 51
for two-sided 

printing 45
Document Quality tab 

40

Help button 40
Job Finishing tab 40
opening

from an application 
39

from Windows 39
Paper tab 40
tabs 39

printer setup
Macintosh 10
Windows 2000 9
Windows 98 6
Windows Me 8

printer software
Control Program 53
installing 6, 9, 10, 11, 

43
Printer Properties 39
uninstalling 73

printer, setting up 1
printing

all photos 27
booklets 48
camera card order 27
from zip drive 35
handouts 47
index 27
on both sides of the 

paper 45
photos 21
posters 50
selected photos 27
sets 27
test page 6
text on photos 29
with a computer 37

printing problems
color quality 70
error messages 63
intermittent 66, 68
missing colors 70
paper jam 65
paper misfeeds 69
with computer 67
without computer 65
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R
release tab 13
reloading instructions, 

two-sided printing 46
removing print cartridge 

54

S
safety information 77
screen, idle 18
Select button

locating 15
using 15

select pages to print 52
selected photos, printing 

27
sets, printing 27
setting recommendations

poster 51
two-sided printing 45

setting up, printer 1
sheet feeder 13
Sheets Per Bundle, 

selecting 49
short edge binding 48
software applications

Control Program 54
software applications, 

Printer Properties 39
software, printer

installing 6, 9, 10, 11, 
43

uninstalling 73
specialty papers

custom size paper 38
iron-on transfers 38
photo cards 38
photo paper 38
transparencies 38

start-up screen, using 17
Status tab 54
storage device, 

connecting 33
storing photos 34

supplies, ordering
power supply 77

T
technical support 71
templates, Kodak 25
test page

alignment 5, 56
does not print 68
nozzle test pattern 57, 

59
printing 6

text
adding to a photo 29
modifying 30

transparencies
loading 38
problems 70

troubleshooting
blank pages 69
color quality 65, 70
general 69
missing colors 57, 70
operator panel error 

messages, 
understanding 63

paper sticks together 
70

printer settings 68
printing problems 65, 

67
problems, computer 

67
two-sided printing

reloading instructions 
46

setting 
recommendations 
45

U
uninstalling printer 

software 73

United Kingdom 
Telecommunications 
Act 1984 76

USB cable
connecting 6
part number 76

USB/PC connection 14

V
View/Return button

locating 15
using 15

W
Warranty 74
Web site, KODAK 15, 71
Windows 2000, printer 

setup 9
Windows 98, printer setup 

6
Windows Me, printer 

setup 8

Z
zip drive

connecting 14, 33
copying to 34
printing from 35
storing photos 34
using 34
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